
Chapter 16

Introduction to Mold
Design

 Learning Objectives 
After completing this chapter, you will be able to:
• Analyze draft angles 
• Add shrinkage
• Create workpiece
• Create mold volumes
• Create parting surfaces
• Create mold components
• Create runners
• Create water lines
• Fill the mold
• Open the mold
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INTRODUCTION TO MOLD DESIGN
In this chapter, you will learn about basic molding process that can be used to design molds 
for plastic molded components in Creo Parametric. Generally, the complete process of mold 
designing consists of designing of mold base, gates and runners, ejection mechanism, and core 
and cavity. But before you learn about mold designing, it is necessary that you learn about some 
of the basic terms related to mold design.

MOLD ASSEMBLY
Mold assembly is an assembly created by assembling a number of parts such as top plate, back 
plate, core back plate, cavity back plate, ejector mechanism, guide bushes, guide pillars, fasteners, 
cooling mechanism, and so on. The complete mold is designed by considering the part to be 
molded and the design depends on the complexity of the part. Some of the elements mentioned 
above are discussed next.

Cavity
Cavity is the female part of the mold and it remains hollow from inside. The molten metal or the 
molten plastic is poured into it so that it can take the shape of the cavity to create the component.

Core
Core is the male part of the mold. It generally helps in defining the holes, pockets, and other 
cut out features of a part while molding.

Shrinkage Factor
Shrinkage factor is defined as the amount by which the molded component shrinks depending 
on the type of material and the shape of the mold. The shrinkage factor is defined in terms of 
percentage.

Parting Line
Parting line is the line which splits and open its respective molds. Figure 16-1 shows an assembly 
of core and cavity with the parting line. Figure 16-2 shows an exploded view of the core and 
cavity assembly with the component that will be created using this combination of core and cavity.

Parting Surface
Parting surface is also used to split a workpiece into core and cavity. In Creo Parametric, you 
can create a parting surface by using three methods which are:

 1. Using skirt surface
 2. Using shadow surface
 3. Creating custom surface created by using surfacing tools
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Figure 16-1  Assembly of core and cavity with the 
parting line

Figure 16-2  Exploded view of the 
core and cavity assembly

Draft Angle
In a molded or cast component, the draft angles are of great importance. If the faces of the core 
and cavity do not have any draft angle, then you cannot take out the molded or cast component 
from the mold. Therefore, it is very important that you should add required draft angles to the 
component.

Runner
It is a channel machined into core and cavity which allows the molten material to flow in between 
them. While designing a runner, the designer should consider the shape of cross section, size 
of runner, and the runner layout.

MOLD DESIGNING USING CREO PARAMETRIC
In Creo Parametric, there are various tools which can be used for mold designing. Some of these 
tools are used in this chapter to create mold design in the following tutorials. In these tutorials, 
you will learn to create molds having single cavity.

TUTORIALS
To perform the tutorials, you need to download the zipped file c16_creo_5.0_input from the 
Input Files section of the CADCIM website. The complete path for downloading the file is:

Textbooks > CAD/CAM > Creo Parametric > Creo Parametric 5.0 for Designers 5th Edition > 
Input Files > C16_creo_5.0_input

After the file is downloaded, extract the folder to the location C:\Creo Parametric\ and rename 
it as c16.
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Tutorial 1
In this tutorial, you will extract the core and cavity of a plastic cover shown in Figure 16-3. The 
resultant core is displayed in Figure 16-4 and the cavity is displayed in Figure 16-5. Figure 16-6 
shows an exploded view of the assembly of the Mold Base.        (Expected time: 60 min)

Figure 16-3  Rotated view of plastic cover

Figure 16-4  Rotated view of core of the Plastic Cover
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Figure 16-5  Rotated view of cavity of the Plastic Cover

Figure 16-6  Exploded view of the Mold Base assembly

 The following steps are required to complete this tutorial:

a. Open the model.
b. Analyze the model for draft by using the Draft tool.
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c. Activate the Manufacturing mode. 
d. Add shrinkage.
e. Create workpiece.
f. Create parting surface.
g. Split volumes.
h. Create runners.
i. Explode assembly.

 When you start a Creo Parametric session, the first task is to set the working directory. Make 
sure the required working directory is selected.

Starting Creo Parametric and Opening a Model
1. Start Creo Parametric by double-clicking on the Creo Parametric icon on the desktop of 

your computer.

2. Choose the Open button in the Home tab; the File Open dialog box is displayed. Browse 
to the location where you have stored the downloaded file. Select tut_1.prt and choose the 
Open button in the dialog box to open the model.

Analyzing the Model for Draft Angles
 As discussed earlier, before extracting the core and cavity, you need to make sure that the 

required draft angles are applied to the model so that the component can easily be removed 
from the core after solidification. Therefore, you will analyze the model using the Draft tool.

1. Choose the Mold/Cast tool from the Engineering group of the Applications tab; the 
Creo Parametric 5.0 window is displayed with the Mold & Cast tab chosen. Figure 16-7 
shows the tools available in the Mold & Cast tab. 

Figure 16-7  Tools in the Mold & Cast tab

2. Choose the Draft tool from the Analysis group of the Mold & Cast tab; the Draft 
Analysis dialog box is displayed, as shown in Figure 16-8. 

3. Activate the Surface collector and select the model in the Surface collector by selecting 
TUT_1.PRT from the Model Tree.

4. Clear the Use the pull direction check box and then click in the Direction collector. Next, 
select the FRONT datum plane in the Model Tree; the Color Scale dialog box is displayed.

5. Change the value of the draft to 3 in the Draft edit box in the Draft Analysis dialog box if 
not set by default. Next, expand the Color Scale dialog box by choosing the down arrow at 
the bottom right corner and then change the value in the Number edit box of the Settings 
area to 3, as shown in Figure 16-9. 
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Figure 16-8  The Draft 
Analysis dialog box

Figure 16-9  Partial view of the expanded 
Color Scale dialog box

 You will notice that the faces having a positive draft and a negative draft are displayed in 
blue and peach color, respectively. Also, some faces with neutral draft angle are displayed 
in grey color. Figure 16-10 shows the model after draft analysis.

Figure 16-10  Model after draft analysis

6. Choose the OK button from the Draft Analysis dialog box and save your file. Choose the 
Close button from the Quick Access toolbar to close the current file.

Starting the Manufacturing Mode 
1. Choose the New button from the Data group; the New dialog box is displayed. Select the 

Manufacturing radio button from the Type area of the New dialog box and select the 
Mold cavity radio button from the Sub-type area; the default name of the sketch appears 
in the File name edit box.
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2. Enter c16tut1 in the File name edit box and clear the Use default template check box. Next, 
choose the OK button; the New File Options dialog box is displayed.

3. Choose the mmns_mfg_mold option and choose the OK button; the Mold environment of 
the Manufacturing mode is activated.

Importing the Model
1. Choose the Locate Reference Model tool from

Figure 16-11  The Create Reference 
Model dialog box

 
the Reference Model drop-down in the Reference 
Model & Workpiece group of the Mold tab; the 
Open dialog box is displayed. Select tut_1.prt and 
choose the Open button in the dialog box to open 
the model; the Create Reference Model dialog 
box is displayed, as shown in Figure 16-11. 

2. Select the Same model radio button from 
the Reference model type area in the Create 
Reference Model dialog box and choose the OK 
button; the Layout dialog box is displayed. Choose 
the OK button and choose the Done/Return 
option from the Menu Manager. The inserted part 
is displayed in the drawing area with the PULL 
DIRECTION arrow along the z-axis, as shown in 
Figure 16-12. 

Figure 16-12  Model after insertion in the Mold environment

Adding Shrinkage
 Before proceeding, you need to add shrinkage factor to the model. As discussed earlier, the 

scaling of the model is done in order to create a core and cavity larger than the component 
to be manufactured as the component shrinks after solidification. The shrinkage factor 
always depends on the material to be used for molding or casting and also on the type of 
mold.



Introduction to Mold Design                                  16-9

1. Choose the Shrink by scale tool from the Shrinkage drop-down

Figure 16-13  The Shrinkage 
By Scale dialog box

 
in the Modifiers group; the Shrinkage By Scale dialog box 
is displayed, as shown in Figure 16-13. 

2. Select the DEFAULT_CSYS coordinate system from the 
drawing area. Next, enter 0.01 in the Shrink Ratio edit box 
of the Shrinkage By Scale dialog box and choose the  
button.

Creating the Workpiece
 Now, you need to create a workpiece. Workpiece is needed to 

create core and cavity to complete the mold process.

1. Choose the Automatic Workpiece tool from the Workpiece 
drop-down in the Reference Model & Workpiece group; the 
Automatic Workpiece dialog box is displayed. 

2. Next, select the MOLD_DEF_CSYS coordinate system from 
the Model Tree. Then enter 80 in the Uniform Offsets edit 
box in the Offsets area of the Automatic Workpiece dialog 
box and press ENTER. Next, choose the OK button.

 Figure 16-14 shows the model inside the workpiece. Clear visibility of all datums from the 
Datum Display Filters drop-down list in the Graphics toolbar.

Figure 16-14  Model inside the workpiece

Creating a Parting Surface
 In this tutorial, you are going to use skirt surface as a parting surface. Now, to create a skirt 

surface, first you need to create a silhouette curve.
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1. Choose the Silhouette Curve tool from the Design Features group; the Silhouette  
Curve dashboard is displayed. Next, choose the Loop Selection tab; the Loop 
Selection slide-down panel is displayed.

2. Choose the Chains tab in the Loop Selection slide-down panel and select the Lower option 
from the 2-1 and 3-1 drop-down lists. Next, choose the OK button to create the silhouette 
curve.

3. Choose the Parting Surface tool from the Parting Surface drop-down in the Parting  
Surface & Mold Volume group; the Parting Surface dashboard is displayed.

4. Choose the Skirt Surface tool from the expanded Surfacing group of the  
Parting Surface dashboard; the Skirt Surface dialog box along with the Menu Manager 
is displayed, as shown in Figures 16-15 and 16-16, respectively.

Figure 16-15  The Skirt Surface dialog box Figure 16-16  The Menu Manager

5. Select the silhouette curve created by the Silhouette Curve tool from the drawing area and 
choose the Done option from the Menu Manager.

6. Choose the OK button from the Skirt Surface dialog box and choose the OK button from 
the Controls group of the Parting Surface dashboard; parting surface is created, as shown 
in Figure 16-17.
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Figure 16-17  Mold with parting surface

Splitting the Workpiece
 To create core and cavity, you need to split the workpiece by using the parting surface. But 

before splitting the workpiece, you need to cutout the model from the workpiece.

1. Choose the Refpart Cutout tool from the Parting Surface & Mold Volume group of  
the Mold tab to cut the reference model from the workpiece; the Refpart Cutout 
dashboard is displayed. Next, choose the OK button to complete the cutout. 

2. Choose the Volume Split tool from the Mold Volume drop-down of the Parting  
Surface & Mold Volume group; the Volume Split dashboard is displayed.

3. Click in the Mold volume to split collector and select Refpart Cutout 1 from the Model 
Tree if not already selected. Next, click in the Parting surface for splitting the mold volume 
collector and select the Skirt Surface id nnn from the drawing area by pressing the CTRL 
key; you will notice that your model is highlighted in orange color.

4. Choose the OK button to complete the process.

Creating Core and Cavity
1. Choose the Cavity insert tool from the Mold Component drop-down of the  

Components group to create core and cavity for the reference model; the Create Mold 
Component dialog box is displayed. 

2. Choose the Advanced option from the Create Mold Component dialog box; the Create 
Mold Component dialog box gets expanded. Next, select Volume_1 from the upper area of 
the Create Mold Component dialog box. Next, select Volume_1 from the Advanced area, 
as shown in Figure 16-18, and change the name Volume_1 to Core_1 in the Name edit box 
of the Mold Component area.

3. Similarly, change the name of Volume_2 to Cavity_1.
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Figure 16-18  The Create Mold Component dialog box

4. Press the CTRL key and select Volume_1 and Volume_2 from the upper area of the Create 
Mold Component dialog box and choose the OK button; Core_1 and Cavity_1 are created 
and added to the Model Tree.

Creating Runner
 As discussed earlier, runners are crucial part of mold design because they are required to 

provide passage for molten material to flow in the mold. But before creating runner in the 
mold, you need to hide all the parts except Cavity_1 from the Model Tree.

1. Choose the Runner tool from the Production Features group to create runner  
in the mold; the Runner dialog box along with the Menu Manager is displayed, 
as shown in Figures 16-19 and 16-20, respectively.

Figure 16-19  The Runner dialog box Figure 16-20  The Menu Manager
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2. Select the Round option from the Shape rollout in the Menu Manager; the Enter runner 
diameter edit box is displayed. Enter 10 in this edit box and press ENTER.

3. Select the bottom face of Cavity_1 as the sketching plane for creating runner, as shown 
in Figure 16-21. Next, choose the Okay option in the DIRECTION rollout of the Menu 
Manager and select the Default option from the SKET VIEW rollout of the Menu Manager; 
the sketcher environment gets activated.

Figure 16-21  Face to be selected as a sketching plane

 Now, you need to create a path for the runner by drawing a line in place of the runner. But 
first you need to select two edges to make them reference axes for the sketch. Select any two 
edges to make reference axes.

4. Draw and dimension a line sketch, as shown in Figure 16-22 and choose the OK button from 
the Sketch dashboard; the Intersected Components dialog box is displayed.
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Figure 16-22  Sketch for profile of the runner

5. Select the Automatic update check box in the Intersected Components dialog box. Next, 
choose the  button to select all the components that are going to intersect the runner 
after the procedure is completed and choose the OK button; the Runner dialog box is 
displayed. Choose the OK button to complete the procedure. 

 You will notice that a cutout appears in the Cavity_1. Now, unhide Core_1 from the Model 
Tree.

Creating Mold Component
 Now, you need to fill the core and cavity parts to create a mold component.

1. Choose the Create Molding tool from the Components group to create mold component; 
the Enter Part name edit box is displayed at the top of the drawing area. 

2. Enter Molding as a part name in the Enter Part name edit box and press ENTER; another 
edit box is displayed. Accept the default value and press ENTER. The mold component is 
created.

Exploding the Mold Assembly
 Now, you need to explode the mold assembly that you have created.

1. Choose the Mold Opening tool from the Analysis group to explode the mold  
assembly; the Menu Manager is displayed. 

2. Select the Define Step option from the MOLD OPEN rollout of the Menu Manager; the 
Menu Manager gets modified. Next, choose the Define Move option from the DEFINE 
STEP rollout and select Cavity_1 from the drawing area and then press the middle mouse 
button.
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3. Select an edge, as shown in Figure 16-23; you are prompted to enter the movement 
displacement. Enter 250 and press ENTER. Next, choose the Done option from the Menu 
Manager; the Cavity_1 moves upward, refer to Figure 16-24.

Figure 16-23  Edge to be selected

 Similarly, you need to move Core_1 from the assembly too.

4. Repeat step 2 and select Core_1 from the drawing area instead of Cavity_1.

5. Select an edge, as shown in Figure 16-24; you are prompted to enter the value of movement 
displacement. Enter -250 and press ENTER. Next, choose the Done option from the Menu 
Manager; the mold assembly gets exploded, as shown in Figure 16-25.

Figure 16-24  Edge to be selected

6. Choose the Done/Return option from the Menu Manager to exit the Mold Opening tool.
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Figure 16-25  Exploded view of mold assembly
 

Saving and Closing the Model
 Now, you need to save the model.

1. Choose the Save button from the File menu and save the model. Then, choose the Close 
button to exit.

Tutorial 2
In this tutorial, you will extract the core and cavity of a plastic component shown in Figure 16-26. 
The resultant core is displayed in Figure 16-27 and the cavity is displayed in Figure 16-28. 
Figure 16-29 shows an exploded view of the assembly of the Mold Base.   (Expected time: 60 min)
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Figure 16-26  Rotated view of the plastic component

Figure 16-27  Rotated view of core of the Plastic Component

Figure 16-28  Rotated view of cavity of the Plastic Component
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Figure 16-29  Exploded view of Mold Base assembly

 The following steps are required to complete this tutorial:

a. Open the model.
b. Analyze the model for draft.
c. Open the Manufacturing mode. 
d. Add shrinkage.
e. Create workpiece.
f. Create parting surface.
g. Split volumes.
h. Create runners.
i. Create Waterlines. 
j. Explode assembly.

 When you start the Creo Parametric session, the first task is to set the working directory. 
Make sure the required working directory is selected.

Starting Creo Parametric and Opening a Model
1. Start Creo Parametric by double-clicking on the Creo Parametric icon on the desktop of 

your computer.
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2. Choose the Open button in the Home tab; the File Open dialog box is displayed. Browse 
to the location where you have stored the downloaded file. Select tut_2.prt and choose the 
Open button in the dialog box to open the model.

Analyzing the Model for Draft Angles
1. Choose the Mold/Cast tool from the Engineering group of the Applications tab; the 

Creo Parametric 5.0 window is displayed with the Mold & Cast tab chosen. Figure 16-7 
shows the tools available in the Mold & Cast tab. 

2. Choose the Draft tool from the Analysis group of the Mold & Cast tab; the  Draft 
Analysis dialog box is displayed. 

3. Select the model in the Surface collector by selecting TUT_2.PRT from the Model Tree 
after activating the Surface collector.

4. Clear the Use the pull direction check box and then click in the Direction collector. Next, 
select the FRONT datum plane in the Model Tree; the Color Scale dialog box is displayed.

5. Change the value of draft to 3 in the Draft edit box in the Draft Analysis dialog box, if not 
set by default. Next, expand the Color Scale dialog box by choosing the down arrow at the 
bottom right corner of the Color Scale dialog box. Next, change the value in the Number 
edit box of the Settings area to 3. 

 You will notice that the faces having positive draft and negative draft are displayed in blue 
and peach color respectively. Also, some faces with neutral draft angle are displayed in grey 
color. Figure 16-30 shows the model after draft analysis.

Figure 16-30  Model after draft analysis

6. Choose the OK button from the Draft Analysis dialog box and save the file. Choose the 
Close button from the Quick Access toolbar to close the current file.

Starting the Manufacturing Mode 
1. Choose the New button from the Data group; the New dialog box is displayed. Select the 

Manufacturing radio button from the Type area of the New dialog box and select the Mold 
cavity radio button from the Sub-type area; the default name of the sketch appears in the 
Name edit box.
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2. Enter c16tut2 in the File name edit box and clear the Use default template check box. Next, 
choose the OK button; the New File Options dialog box is displayed.

3. Choose the mmns_mfg_mold option and then choose the OK button; the Mold environment 
of the Manufacturing mode is activated.

Importing the Model
1. Choose the Locate Reference Model tool from the Reference Model drop-down in the 

Reference Model & Workpiece group of the Mold tab; the Open dialog box is displayed. 
Select tut_2.prt and choose the Open button in the dialog box to open the model; the Create 
Reference Model dialog box is displayed. 

2. Select the Same model radio button from the Reference model type area in the Create 
Reference Model dialog box and choose the OK button; the Layout dialog box is displayed. 
Choose the OK button and then choose the Done/Return option from the Menu Manager. 
The inserted part is displayed in the drawing area with the PULL DIRECTION arrow along 
the z-axis, as shown in Figure 16-31. 

Figure 16-31  Model after inserting in the Mold environment

Adding Shrinkage
 Before proceeding further, you need to add shrinkage factor to the model. As discussed 

earlier, the scaling of the model is done in order to create core and cavity larger than the 
component to be manufactured as the component shrinks after solidification. The shrinkage 
factor always depends on the material to be used for molding or casting and also on the 
type of mold.

1. Choose the Shrink by scale tool from the Shrinkage drop-down in the Modifiers group; 
the Shrinkage By Scale dialog box is displayed.

2. Select the DEFAULT_CSYS coordinate system from the drawing area. Next, enter 0.01 in 
the Shrink Ratio edit box of the Shrinkage By Scale dialog box and choose the  button.
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Creating the Workpiece
 Now, you need to create a workpiece. Workpiece is needed to create core and cavity to 

complete the mold process.

1. Choose the Automatic Workpiece tool from the Workpiece drop-down in the Reference 
Model & Workpiece group; the Automatic Workpiece dialog box is displayed. 

2. Select the MOLD_DEF_CSYS coordinate system from the Model Tree. Then enter 80 in 
the Uniform Offsets edit box in the Offsets area of the Automatic Workpiece dialog box 
and press ENTER. Next, choose the OK button.

 Figure 16-32 shows the model inside the workpiece. Clear visibility of all datums from the 
Datum Display Filters drop-down list in the Graphics toolbar.

Figure 16-32  Model inside the workpiece

Creating a Parting Surface
 In this tutorial, you will use the Extend Curve tool to create a parting surface.

1. Choose the Parting Surface tool from the Parting Surface drop-down in the Parting  
Surface & Mold Volume group; the Parting Surface dashboard is displayed.

2. Choose the Extend Curve tool from the Surfacing group of the Parting Surface  
dashboard; the Extend Curve dashboard is displayed, as shown in Figure 16-33.

Figure 16-33  Partial view of the Extend Curve dashboard
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3. Now, press the CTRL key and select all the edges of the

Figure 16-34  Edges to be selected

 
bottom face which are highlighted in green color in the 
Chain collector in the drawing area, refer to Figure 16-34. 
Next, choose the Extensions tab of the Extend Curve 
dashboard; the Extensions slide-down panel is displayed.

4. Select the Perpendicular to boundary radio button from 
the Extensions slide-down panel and choose the OK button 
from the Extend Curve dashboard; the extending surface 
is created, as shown in Figure 16-35.

 Now, you need to fill the slots present in the model.

5. Choose the Fill Loops tool from the Surfacing group of the 
Parting Surface dashboard; the Fill Loops dashboard is displayed. Next, select all the inner 
edges of both the slots by pressing the CTRL key in the Chain Collector from the drawing 
area and choose the OK button; slots are filled with surface, as shown in Figure 16-36.

Figure 16-35  Model after using the Extend 
Curve tool

Figure 16-36  Model after using the Fill 
Loops tool

6. Choose the OK button from the Controls group of the Parting Surface dashboard; the 
parting surface is created, refer to Figure 16-36.

Splitting the Workpiece
 To create core and cavity, you need to split the workpiece by using the parting surface. But 

before splitting the workpiece, you need to cutout the model from the workpiece.

1. Choose the Refpart Cutout tool from the Parting Surface & Mold Volume group of  
the Mold tab to cut the reference model from the workpiece; the Refpart Cutout 
dashboard is displayed. Next, choose the OK button to complete the cutout. 

2. Choose the Volume Split tool from the Mold Volume drop-down of the Parting Surface & 
Mold Volume group; the Volume Split dashboard is displayed.

3. Click in the Mold volume to split collector and select Refpart Cutout 1 from the Model 
Tree, if not already selected. Next, click in the Parting surface for splitting the mold volume 
collector and then select both the surfaces created as the parting surface from the drawing 
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area by pressing the CTRL key; you will notice that your model is highlighted in orange 
color.

4. Choose the OK button to complete the process.

Creating Core and Cavity
1. Choose the Cavity insert tool from the Mold Component drop-down of the  

Components group to create core and cavity for the reference model.; the Create 
Mold Component dialog box is displayed. 

2. Choose the Advanced option of the Create Mold Component dialog box; the Create Mold 
Component dialog box gets expanded. Next, select Volume_1 from the upper area of the 
Create Mold Component dialog box. Next, select Volume_1 from the Advanced area and 
change the name Volume_1 to Core_2 in the Name edit box of the Mold Component area.

3. Similarly, change the name of Volume_2 to Cavity_2.

4. Press the CTRL key, select Volume_1 and Volume_2 from the upper area of the Create Mold 
Component dialog box and choose the OK button; Core_2 and Cavity_2 are created and 
added to the Model Tree.

Creating Runner
 As discussed earlier, runners are crucial part of the mold design because they are required 

to provide passage for molten material to flow in the mold. But before creating runner in 
the mold you need to hide all the parts except Cavity_2 from the Model Tree.

1. Choose the Runner tool from the Production Features group to create runner  
in the mold; the Runner dialog box along with the Menu Manager is displayed.

2. Select the Round option from the Shape rollout in the Menu Manager; the Enter runner 
diameter edit box is displayed. Enter 10 in this edit box and press ENTER.

3. Select the bottom face of Cavity_2 as the sketching plane for runner, as shown in Figure 16-37. 
Next, choose the Okay option in the DIRECTION rollout of the Menu Manager and 
select the Default option from the SKET VIEW rollout of the Menu Manager; the sketcher 
environment gets activated.
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Figure 16-37  Face to be selected as a sketching plane

 Now, you need to create a path for the runner by drawing a line in place of the runner. But 
first you need select two edges to make them reference axes for the sketch. Select any two 
edges to make reference axes.

4. Draw and dimension a line sketch, as shown in Figure 16-38 and choose the OK button from 
the Sketch dashboard; the Intersected Components dialog box is displayed.

Figure 16-38  Sketch for profile of the runner

5. Select the Automatic update check box in the Intersected Components dialog box. Next, 
choose the  button to select all the components that are going to intersect the runner after 
the procedure is complete and choose the OK button; the Runner dialog box is displayed. 
Choose the OK button to complete the procedure. 

 You will notice that a cutout appears in the Cavity_2. Now, unhide Core_2 from the Model 
Tree.

Creating Water Lines
 Now, you need to add water lines to reduce the time consumed by molten plastic to solidify. 

But, first you need to create two datum planes to specify the location of water line.
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1. Create one datum plane at an offset of 50 mm from the top surface of the workpiece towards 
Core. Similarly, create another plane at an offset of 50 mm from the bottom face of the 
workpiece towards Cavity.

 Now, select Core_2 and Cavity_2 from the Model Tree and change their visibility to 
transparent by choosing the Transparent option from the Component Display Style flyout 
in the expanded Model Display group of the View tab.

2. Choose the Water Line tool from the Production Features group of the Mold tab to create 
water lines; the Enter diameter of waterline circuit edit box along with the Water Line 
dialog box is displayed. 

3. Enter 10 as a value of diameter in the Enter diameter of waterline circuit edit box and 
press ENTER; the Menu Manager is displayed. Next, select ADTM1 as the sketching plane 
from the Model Tree for water line. Next, choose the Default option from the SKET VIEW 
rollout of the Menu Manager; the sketcher environment gets activated.

 Now, you need to create circuit for the water line by drawing lines in place of water lines. 
But first you need to select two edges to make them reference axes for the sketch. Select any 
two edges to make them reference axes.

4. Draw and dimension a line sketch, as shown in Figure 16-39 and choose the OK button from 
the Sketch dashboard; the Intersected Components dialog box is displayed.

Figure 16-39  Sketch for circuit of the water lines

5. Select the Automatic update check box in the Intersected Components dialog box. Next, 
choose the  button to select all the components that are going to intersect the water lines 
after the procedure is completed and choose the OK button; the Water Line dialog box is 
displayed. Choose the OK button to complete the procedure.

 Now, you need to create water lines in Core part.
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6. Choose the Water Line tool from the Production Features group to create water lines; 
the Enter diameter of waterline circuit edit box along with the Water Line dialog box is 
displayed. 

7. Enter 10 as the value of diameter in the Enter diameter of waterline circuit edit box and 
press ENTER; the Menu Manager is displayed. Select ADTM2 as the sketching plane for 
water line. Next, choose the Default option from the SKET VIEW rollout of the Menu 
Manager; the sketcher environment gets activated.

 Now, you need to create circuit for the water line by drawing lines in place of water lines. But 
first you need to select two edges to make them reference axes for the sketch. Select any two 
edges to make them reference axes. Next, follow steps 4 and 5 to complete the procedure.

 Water lines are created, as shown in Figure 16-40. Now, change the visibility of the Core_2 
and Cavity_2 back to Shaded.

Figure 16-40  Mold with water lines

Creating Mold Component
 Now, you need to fill the core and cavity parts to create a mold component.

1. Choose the Create Molding tool from the Components group to create mold component; 
the Enter Part name edit box is displayed. 

2. Enter Molding as the part name in the Enter Part name edit box and press ENTER; another 
edit box is displayed. Accept the default value in the edit box and press ENTER. The mold 
component is created.

Exploding the Mold Assembly
 Now, you need to explode the mold assembly you have created.

1. Choose the Mold Opening tool from the Analysis group to explode the mold  
assembly; the Menu Manager is displayed. 



Introduction to Mold Design                                  16-27

2. Select the Define Step option from the MOLD OPEN rollout of the Menu Manager; the 
Menu Manager gets modified. Next, choose the Define Move option from the DEFINE 
STEP rollout and select Cavity_2 from the drawing area and press the middle mouse button.

3. Select an edge, as shown in Figure 16-41; you are prompted to enter the movement 
displacement. Enter 250 and press ENTER. Next, choose the Done option from the Menu 
Manager; the Cavity_2 moves upward, refer to Figure 16-41.

 Similarly, you need to move Core_2 from the assembly too.

4. Repeat step 2 and select Core_2 from the drawing area instead of Cavity_2.

Figure 16-41  Edge to be selected

5. Select an edge, as shown in Figure 16-42; you are prompted to enter the movement 
displacement. Enter -250 and press ENTER. Next, choose the Done option from the Menu 
Manager; the mold assembly gets exploded, refer to Figure 16-43.

6. Choose the Done/Return option from the Menu Manager to exit the Mold Opening tool.
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Figure 16-42  Edge to be selected
 

Figure 16-43  Exploded view of the mold assembly
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Saving and Closing the Model
 Now, you need to save the model.

1. Choose the Save button from the File menu and save the model. Then choose the Close 
button to exit.

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1. The __________ tool is used to split workpiece into core and cavity. 

2. The__________ tool is used to analyze the draft of the part.

3. The _________ is the female part of the mold; it is hollow from inside and the molten metal 
or the model plastic is poured into it so that it can take the shape of the cavity to create the 
component.

4. Shrinkage is used to apply scale factor to the component. (T/F)

5. The Fill Loops tool is used to create the surface to close the openings in the model. (T/F)

Review Questions
Answer the following questions:

1. The __________ tool is used to create molding.

2. Silhouette curves are required to create parting surface by using the ___________ tool.

3. The __________ tool is used to add cooling channels to core and cavity.

4. You cannot create a parting surface without creating the silhouette curve first. (T/F)

5. The Cavity insert tool is used to insert core and cavity. (T/F)

EXERCISES
To perform these exercises, you need to download the zipped file named as c16_creo_5.0_input 
from the Input Files section of the CADCIM website. The complete path for downloading the 
file is:

Textbooks > CAD/CAM > Creo Parametric > Creo Parametric 5.0 for Designers 5th Edition > 
Input Files > C16_creo_5.0_input

After the file is downloaded, extract the folder to the location C:\Creo Parametric\ and rename 
it as c16.
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Exercise 1
Create the mold design of the model shown in Figure 16-44.       (Expected time: 60 min)

Figure 16-44  Model for Exercise 1

Exercise 2
Create the mold design of the model shown in Figure 16-45.       (Expected time: 60 min)

Figure 16-45  Model for Exercise 2

Answers to Self-Evaluation Test
1. Volume Split, 2. Draft, 3. cavity, 4. T, 5. T


